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7-3Introduction

Clients & Profits X is based on an industry-standard, one-write, double-entry general 
ledger accounting system. So in addition to tracking production, Clients & Profits 
X can be used to track the shop’s finances. Every A/P, A/R, checkbook, and client 
payment entry creates G/L journal entries automatically using a custom Chart of 
Accounts. Your G/L accounts are updated automatically as records are posted. This 
means you can print financial statements, like a trial balance, an income statement, 
and a balance sheet, any time. They’re always up-to-the-minute accurate. In this 
chapter, you’ll see how to:

■ set up your chart of accounts
■ sort accounts by subclass and profit center
■ set up budgets for income and expenses
■ print audit trails and journals from the General Ledger
■ add journal entries into the general journal
■ import payroll entries
■ set up profit centers
■ set up departments
■ allocate overhead expenses to clients
■ reconcile accounts and make adjusting entries
■ close the year

Introduction

For help using any part of Clients & Profits X, click the    button from any 

window to open the on-line user guide. This web-based user guide features 

step-by-step instructions, explanations, tips, demonstrations, and links to 

FAQs, tech notes, and tutorials from www.cnp-x.com/support. The web site is 

continually updated, so it’s more timely and helpful than a printed user guide.
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General Ledger

Clients & Profits X is built around a one-write, double-entry general ledger. 
This comprehensive, accrual accounting system automatically tracks your 
income, costs, and expenses using a custom, user-defined Chart of Accounts. 
Your G/L accounts track activity totals for multiple accounting periods (24 
in Clients & Profits Pro X and C&P SQL X, 15 in Clients & Profits Classic X). 
The system provides agency-tailored financial statements, including income 
statements, balance sheets, trial balances, detailed general ledgers, journals, 
and audit trails.

The General Ledger is used for financial accounting. This is different than job 
accounting, which deals with costs, billings, and expenses from the job’s 
point-of-view. The General Ledger consolidates all of the work you do—both 
job costs and overhead expenses—to provide a true look at the shop’s net 
income. 

■  Clients & Profits X has everything you need to produce financial state-
ments, so it replaces any existing accounting systems you may be using. You 
do not need additional software programs to manage your books.

Unlike other systems you may have used, not everything affects your General 
Ledger. In fact, only those transactions that involve actual money (such as 
purchases, checks, and client payments) update the G/L; job costs (such as 
time, out-of-pocket expenses, and purchase orders) do not affect your finan-
cial statements. This is important to understand, since it determines how 
you’ll manage your books with Clients & Profits.

Financial reports provide comprehensive auditing and analysis information. 
Financial accounting takes into consideration every expense and income 
dollar in the shop, not just job profitability. Overhead expenses, salaries and 
miscellaneous income are included on the Income Statement along with 
job-related transactions. Assets, accumulated depreciation, liabilities, and 
equity are reported on the Balance Sheet. Audit trails, journals, and ledgers 
help track the transactions included in the financial statement calculations. 
General Ledger account budgets are easily added and printed to analyze the 
account activity more closely. 

Cash vs. accrual explained: Cash basis and accrual basis accounting are the 
two most widely recognized methods of tracking a companies income and 
expenses. The primary difference between the two methods has to do with 
when the recognition of income and expenses occur. Under the cash method, 
income is recognized when a payment is received and expenses when a 
check is written. This method does not let you match revenues generated 
with the costs associated to them, an important financial accounting con-
cept. Under the accrual method (the one used by Clients & Profits X), income 
is recognized when the invoice is sent to the client (posted) and expenses 
are recognized when the payable is recorded on the companies books. It’s a 
better way of recognizing income and expenses for financial purposes as it 
relates the income and expenses more closely to the actual events causing 
them and gives you the ability to properly match the income generated with 
the expenses incurred to produce them. 

General Ledger

Automatic vs. manual 
journal entries

Profit centers and 
departments

Journal entries are added to the 
General Ledger automatically when 
payables, receivables, checks, and 
client payments are posted. 

Invoices that you enter into Ac-
counts Payable, billings that 
you enter into Accounts Receivable, 
checks that you write in the Check-
book, deposits that you enter into 
Client Payments, and employee 
expense reports that 
you enter into Expenses are distinct 
records. Each record creates a sepa-
rate journal entry into the General 
Ledger. So when you see a G/L 
report, you are actually looking at 
the journal entries—not the source 
records, such as the invoice. 

Any manual entries you make 
directly into the General Ledger 
appear on G/L reports; they won’t 
appear on payable, receivable, or 
cash reports. This gives you the 
flexibility of managing your cost 
accounting apart from your finan-
cial accounting.

Profit centers are set up to track a 
division’s finances and each profit 
center has its own chart of ac-
counts. The profit center’s financial 
statements include only general 
ledger numbers that are assigned 
to that profit center. The profit 
center’s transactions post to the G/
L like any other accounts. The only 
difference is that the option can be 
chosen to print financial statements 
for only those accounts. There’s no 
limit to the number of profit centers 
which can be set up.

Departments are used to track 
costs incurred by a group of staff 
members (e.g., the Art Department). 
Separate expense accounts are set 
up for each department and are 
distinguished by a two digit code 
that follows the account number. 
Each account is listed separately 
on financial statements unless the 
roll-up option is used.
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Clients & Profits is a single accounting system, so there are no complicated modules to 
integrate, maintain, or close. 

When someone adds a vendor invoice, check, client invoice, payment, or employee 
expense report, Clients & Profits posts debit and credit journal entries into the Gen-
eral Ledger automatically. Standard (“default”) debit and credit account numbers are 
entered automatically, too, but can be changed. This gives users the flexibility they need 
to accurately account for all kinds of billings, costs, and expenses. In addition, general 
journal entries can be added directly into the General Ledger.

The entries users make don’t update the G/L until they are posted. Each user can 
double-check their own work before posting using proof lists. Proof lists show the debits 
and credits for each transaction they added.

Any vendor invoice, client invoice, check or employee expense report can be coded with 
one or more job numbers and tasks. This tells Clients & Profits to update the job ticket 
as well as the General Ledger. Because the accounting system is integrated with job 
tracking, there’s no double-entry. 
 
In addition to job costs, all kinds of overhead expenses are tracked by Clients & Profits. 
Overhead invoices and checks can debit many expense accounts (and can even be split 
between job cost and overhead G/L accounts).  

The General Ledger is updated every time an invoice, check, or payment is posted, so 
financial reports are also up-to-the-minute accurate. No month-end closing is required 
to print financial statements or aging reports.

Clients & Profits Pro can have 24 months open simultaneously; Clients & Profits Classic 
can have 15 months. Fiscal years are customizable, so they can start at any time during 
the year. Accounting, job costing, and financial analysis reports can be printed for any 
period.

The chart of accounts supports hundreds of separate G/L accounts. A separate set of 
accounts can be created for profit centers or departments for better accountability. 
Each account can have up to a 9-digit account number, as well as customizable class, 
subclass, cash flow, and ratio category settings.

Built-in auditing and reporting tools make it easy to analyze, query, and troubleshoot 
your accounting. Detailed audit trails and journals can show journal entries for any time 
period and for a range of accounts. The innovative Auditor lets you verify your General 
Ledger quickly and easily.

Clients & Profits can handle dozens of different profit centers. Profit centers are inte-
grated with jobs, tasks, staff members, and clients for better accountability. Financial 
statements can be printed for one profit center or for all profit centers. Departmental 
G/L accounts can be set up and used within a profit center for better cost tracking and 
analysis.

Monthly budget amounts can be entered for every G/L account, reducing the need for 
separate budget spreadsheets. Budget amounts can be reviewed on-screen or printed for 
any accounting period or quarter.

One-write, double-entry G/L

Automatic journal entries

Posting with proof lists

Integrated job costing, billing

Overhead accounting

Real-time financials

Multiple accounting periods

Chart of accounts

Auditing tools

Profit centers, departments

Budgeting 

General Ledger Features

Feature How it works, how it’s used
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Job costing and the G/L WIP accounting Overhead accounting Payroll

Direct disbursement checks (e.g., 
postage, prepaid printing, etc.) and 
vendors invoices are costed to one 
or more job tickets. When a check 
or invoice is entered, it’ll be given a 
job number and a job task, which is 
updated when the entry is posted. 
Job tasks are updated with the 
entry’s net cost and gross (i.e., bill-
able) amounts during posting. 

When the client is billed, the 
job’s gross amounts are copied 
automatically from the job ticket to 
the invoice. When the A/R invoice 
is posted, the invoice’s billing 
amounts update the job’s billed 
totals instantly. So the job has an 
up-to-the-minute accounting for all 
costs and billings.

Costs and billings actually copy the 
G/L account numbers from the task 
when the invoices are added. Be-
cause a task usually uses the same 
G/L accounts, (e.g. printing is cost-
ed to printing expense and billed to 
a specific income account), those 
account numbers are entered on 
the task table and copied to the job 
ticket when the task is added. This 
makes the accounting quicker and 
more consistent and reduces errors 
in the General Ledger.

Because billing clients is faster 
with Clients & Profits, it’s much 
easier to create invoices. Where 
billing may have been generated 
at month-end, jobs can now be 
billed immediately upon comple-
tion. Because billing is so much 
more timely, Clients & Profits has 
a unique way of handling unbilled 
work in progress.

Unlike old systems, job costs are 
not accrued into a “WIP” (i.e., 
work in process) liability account. 
Instead, when job costs are posted 
they debit your job costs (i.e., cost 
of sales) G/L accounts immediately. 
This means your Income Statement 
always shows the month’s actual 
job costs, whether they’ve been 
billed or not. When clients are 
billed, the Income Statement will 
show the billings as income; the 
difference between your income 
and job costs is your gross margin 
(i.e., gross profit).

There are always some costs that 
aren’t billed by month-end, but 
they’re typically a fraction of the 
month’s total costs. After the 
month’s billing is finally posted, 
a special G/L Accrual report (see 
Snapshots > Work in Progress > 
Misc) can be printed detailing the 
shop’s unbilled job costs—your 
WIP—for each job cost debit G/L 
account. From this report, a set of 
simple auto-reversing G/L journal 
entries can be added to credit the 
job cost G/L account and debit the 
WIP account. 

Once these entries are posted, your 
financial statements will properly 
reflect the month’s billings, costs, 
and unbilled WIP.

General and administrative ex-
penses that are not directly related 
to clients are specially handled by 
Clients & Profits.

In fact, every overhead expense 
(e.g., rent utilities, office supplies, 
legal fees, etc.) needs to be entered 
into Clients & Profits. Overhead 
expenses can be added from vendor 
invoices in Accounts Payable and 
from checks written for non-job ex-
penses, like office supplies. These 
expenses will appear on financial 
statements 
and G/L reports.

Every expense, whether added 
in A/P or the checkbook, can be 
distributed to one or more debit 
“overhead expense” G/L accounts. 
These expenses appear on the In-
come Statement in the “expenses” 
section.

A standard (i.e., default) overhead 
expense G/L account can be set in 
Preferences (see Setup > Prefer-
ences > G/L Accounts). In addition, 
each overhead vendor can be 
assigned its own special overhead 
G/L account. This account is copied 
automatically 
to overhead expense A/P entries 
and checks, saving time and 
making expense accounting more 
accurate.

Overhead amounts can be easily 
allocated to each client based on 
month-to-date costs, hours, bill-
ings, or income using the Overhead 
Allocation Worksheet (see page 
38). The overhead allocation then 
appears on the Client P&L report 
(see page 7-24).

While Clients & Profits does not 
calculate payroll or print pay 
checks, the shop’s payroll expenses 
must be entered into the General 
Ledger to appear on financial state-
ments.

There are two ways to handle 
payroll: using a separate payroll 
program to calculate and print 
payroll checks, or use an outside 
payroll service (e.g., Paychex, ADP, 
etc.).

In both cases, G/L entries need 
to be added after each payroll. 
If you’re using an outside payroll 
service, the paycheck summary 
report should provide a list of 
debits for salary expense as well as 
the various deductions for taxes, 
contributions, and benefits.

■ For privacy reasons, don’t iden-
tify the employee on the payroll 
entries. The details you enter on 
payroll JEs will appear on G/L 
reports.

If payroll is produced in-house on 
a payroll program like CheckMark, 
journal entries can be imported into 
Clients & Profits .
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Default settings and ac-
counting preferences

Sales tax Year-end closing

Defaults are user-defined settings 
that customize how Clients & Prof-
its works. Default settings let you 
tailor your accounting periods, G/L 
accounts, account classifications, 
and other options to make data 
entry more efficient and accurate. 
They are part of the system’s Pref-
erences, and are very flexible. 

Just as the cost and billing G/L ac-
counts are set up on the Task Table, 
the most essential accounts   (e.g., 
checking, A/R, A/P, Income, etc.) 
are entered as preferences. Once 
entered, they are copied to new 
entries automatically. For example, 
when a vendor invoice is entered, 
the A/P account number is copied 
to the cGL field. Likewise, the A/R 
account number is copied to the 
client invoice dGL field.

■  For more information, see Set-
tings, section 9.

Clients & Profits calculates, 
charges, and tracks sales tax by cli-
ent. The sales tax system involves 
clients, job tasks, and Accounts 
Receivable.

First, a standard tax rate for two 
different sales taxes for your area 
can be entered into Preferences 
(see Setup > Preferences > Sales 
Tax). This rate is copied automati-
cally to new clients. Each client 
can have its own separate sales tax 
rates, or none at all. Sales tax is 
calculated in A/R by multiplying an 
invoice’s taxable billing amounts by 
the client’s sales tax rate (or rates). 
Sales tax also appears on printed 
estimates.

Sales tax is calculated on taxable 
job tasks. Each task in the Task 
Table can be marked as taxable or 
nontaxable. When the task is added 
to a job ticket, it’s taxable status 
is copied automatically. However, 
sales tax on a job ticket is fully cus-
tomizable: a particular job can be 
fully taxable, partially taxable (i.e., 
by task), or completely nontaxable.

Sales tax only affects the General 
Ledger when the client’s invoice 
in A/R is posted (which credits 
the sales tax liability account) and 
when a sales tax check is written 
to the State (which then reconciles 
the sales tax liability). The shop’s 
current sales tax liability appears 
on the Balance Sheet. In addition, 
a detailed sales tax analysis report 
can be printed from A/R to show 
sales tax charges by client and tax 
area (i.e., county).

■ For information on GST, please 
call the Clients & Profits Helpdesk 
at (800) 521-2166, 

Clients & Profits keeps the current 
year’s accounting on-line and avail-
able until the fiscal year is closed. 
Closing the fiscal year moves the 
G/L totals from the “current year” 
column to the “last year” column, 
then erases the year’s journal 
entries. 

There’s no real urgency to close 
the year, since Clients & Profits can 
handle two full fiscal years. The 
first fiscal year can be closed any 
time during the following twelve 
months. New work for the second 
fiscal year can be added into 
periods 13, 14, 15, etc. just like any 
other period. When the fiscal year 
is eventually closed, periods 13, 14, 
and 15 become periods 1, 2, and 3 
of the new fiscal year. The year-end 
closing procedure automates every-
thing, and can be run unattended 
(see page 6-46).

■ Year-end closing only affects the 
General Ledger. All of the year’s job 
tickets, agings, time sheets, POs, 
and other activity remain intact and 
unchanged.

■  Once the fiscal year has closed, 
no financial statements or G/L 
reports can be printed it. These 
reports will only show data for the 
new fiscal year. That’s why it’s 
important to print all year-end and 
year-to-date financial reports, as 
well as make a permanent, archive 
copy of your C&P database, BEFORE 
closing the year. (If you ever need 
to see some G/L records from a 
previous fiscal year, they’ll be on 
the backup archive copy).

A fiscal year is a twelve-month 
period from which your accounting 
year starts and ends. In Clients & 
Profits, the fiscal year includes 24 
periods which generally correspond 
to the months in the year (i.e., pe-
riod 12 for December), but they’re 
user-defined.

The costs, billings, and expenses 
you enter are posted into a user-
defined accounting period. The cur-
rent period, which is user-defined, 
is copied automatically onto all 
entries during that month. Account-
ing periods don’t automatically 
change at the beginning on each 
new month. Instead, the current 
period is updated manually once 
most of the previous month’s work 
has been entered.

Financial statements are printed 
for one or more accounting periods, 
showing the total costs, billings, 
and expenses posted so far into 
that period. All of the year’s ac-
counting periods are potentially 
open, and reports can be printed for 
any period throughout the year. 

One of the first things you’ll do 
when starting Clients & Profits 
is to define your fiscal years and 
accounting periods in Preferences 
(see Setup > Preferences > Ac-
counting Periods). Your fiscal year 
can begin on the first day of any 
month. 

■ Be sure to consult your CPA 
before setting your accounting 
preferences. Once you’ve begun 
entering work into the fiscal year, 
it is very difficult to change your 
accounting periods. 

Accounting periods and 
fiscal years
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The General Ledger window

The General Ledger window

Reference numbers

Each journal entry has a unique 
reference number. This number 
identifies the source of the journal 
entry, and can be used to find any 
particular transaction. 

Most journal entries are numbered 
automatically. This reference num-
ber is based on the transaction’s 
source. Entries posted from Ac-
counts Receivable have the prefix 
AR#. Similarly, Accounts Payable is 
AP#, Checkbook is CK#, and Client 
Payments is PMT#. You can tell 
where and how a journal entry was 
added by its reference number.

Entries posted directly in the gen-
eral ledger may have a user-defined 
reference number. Normally the 
default JE number is used. But any 
kind of number, including any com-
bination of letters and numbers, 
can be used. A starting JE number 
can be set in Preferences.

Entry dates, posting 
dates, and accounting 
periods

Journal entries are dated automati-
cally. Dates are used for reference 
on audit trails and journals, but 
don’t affect the general ledger or 
financial statements. G/L reports 
can be printed showing journal 
entries by date added (the invoice, 
payment, or check date) or date 
posted.

Financials are updated exclusively 
using the journal entry’s accounting 
period. So the dates on journal en-
tries don’t affect the general ledger 
or financial statements.

The dates on automatic journal 
entries (i.e., those posted in A/P, 
A/R, the Checkbook, and Client 
Payments) are copied from the 
vendor invoices, client invoices, 
checks, and client payments 
themselves. The date added and 
date posted won’t always be the 
same; for instance, you may post 
an entry several days after it has 
been added.

A period is chosen for each 
transaction. The current period, set 
up in Preferences, is entered by 
default but can be changed. The 
transaction posts into the selected 
accounting period. 

The General Ledger window is the “operations center” of your accounting 
system. It’s where you see G/L transactions (i.e., vendor invoices, client pay-
ments, checks, adjusting entries, etc.), add manual general journal entries, 
and use the built-in G/L tools to audit your books.

The G/L window lets you see the many A/P, A/R, checkbook, and client 
payment journal entries in your General Ledger. In fact, it’s the only window 
where you can see the transactions from your General Ledger. 

Journal entries are listed on General Journal reports and update financial 
statements when posted. Manually added JEs appear on audit trails, journals, 
and the Detailed G/L report together with automatic journal entries (i.e., 
those posted from Accounts Payable, Accounts Receivable, the Checkbook, 
Client Payments, and Employee Expense Reports). Both kinds of entries affect 
your financials equally; manual entries, however, don’t affect job totals, cli-
ent balances, or vendor balances.

Journal entries are grouped together by reference number so you can see the 
complete transaction in its full debit-and-credit detail. The window displays a 
transaction’s journal entries 

The window’s toolbar buttons let you browse through journal entries, as well 
as add new ones. The window’s File and Edit menus contain commands for 
adding, editing, deleting journal entries, as well as printing G/L reports.

■  Printing one G/L transaction: You can easily print contents of the G/L 
window, giving you a hard-copy report of the currently-displayed entry, by 
choosing File > Print Window. 

Reference Numbers
Prefix: Posted from

AR# Accounts Receivable

AP# Accounts Payable

CK# Checkbook

PMT# Client Payments

JE# General Ledger

WIP# Media Accruals

EXP# Employee Expense Reports
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Cloning Journal Entries Proofing Journal Entries

Cloning makes an exact duplicate 
of an existing transaction’s debit 
and credit journal entries.  You can 
clone any general journal entry, 
even from previous accounting 
periods.  

To clone a journal entry:

1  Use the find link to locate the 
general journal transaction you 
wish to clone.

2  Click on the clone button in the 
General Ledger window.

The Add Journal Entries window 
opens, displaying the  newly-cloned 
transaction.  The new entry has 
today’s date, the current period, 
and the next automatic reference 
number (copied from your account-
ing preferences).  But the descrip-
tion and debit and credit journal 
entries are identical to  the original 
transaction.

3  Make any necessary changes to 
the cloned debits and credits, then 
click Save.

Once saved, the cloned entry can 
be proofed and posted like any 
other entry.

Proofing is very important, since 
it allows users to fix errors before 
the entries become permanent. The 
General Ledger proof list shows 
all unposted journal entries which 
were added directly into the General 
Ledger. Journal entries are grouped 
by transaction, according to the 
reference number. Each entry lists 
its account number, debit or credit 
amount, and description.

There are several useful proofing 
options:

■ Proof/post only JEs added by: 
Since newly-added journal entries 
are automatically tagged with the 
user’s initials, it’s easy for users 
to print their own proof lists. Only 
the entries that they added will be 
shown on the proof list. You can 
print proof lists for them by clicking 
the “proof/post only JEs added by” 
option then entering their initials. 
This is especially useful if many 
people add G/L entries. A user’s 
access privileges can even be 
restricted so they can only post their 
own entries.

■  Proof/post only JEs for period: 
At month-end there may be times 
when you’re adding G/L entries for 
both the current period and the next 
period (or maybe even a previous 
period, as long as it’s not locked). 
Rather than see all unposted entries, 
you can print a proof list showing 
only those entries in the current pe-
riod by using this option. Any period 
can be entered, so a proof list can 
be printed only showing unposted 
entries for the previous period, the 
current period, and the next period.

■  Include recurring entries: If you’ve 
scheduled recurring entries far into 
the future, the only way to print a re-
port of recurring entries is to include 
them on a proof list. 

Posting updates the account totals 
in your General Ledger. When 
a general journal transaction is 
added, its journal entries (there 
could be many) are not posted. 
Unposted entries can be easily 
and quickly changed, letting you 
edit an entry’s reference number, 
description, and other details.

Unposted journal entries don’t 
appear on audit trails, journals, or 
financial statements. This offers 
users a chance to proof their work 
before posting.  Posting makes 
the entries permanent. It is a me-
thodical process that updates your 
account balances. The process is 
the same whether you’re posting 
entries from one transaction or 
many transactions. 

Journal entries must be posted. 
They can be posted individually by 
transaction, as needed. Or, they 
can be posted in batches. Journal 
entries should be proofed for accu-
racy before posting. Proofing lets 
you check your entries for errors, 
then make changes. Proofing lets 
you avoid making time-consuming 
adjusting or reversing entries.

■  Only manually-added journal 
entries can be posted 
from the General Ledger. Most 
journal entries are created 
automatically when payables, 
receivables, checks, client pay-
ments, and employee expense 
reports are posted.

■  Posting journal entries does 
not affect clients, vendors, 
jobs, or tasks. Only your G/L 
account balances are updated.

Posting Journal Entries
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The General Ledger window (con’t)

1  The arrow toolbar buttons 
can be used to scroll through 
the previous and next journal 
entries.

2  Use these toolbar buttons to 
add, clone, edit, edit amounts, 
and delete journal entries.  
Click  on the add button to add 
a new journal entry. Existing 
general journal entries can be 
easily cloned into new journal 
entries by using the clone 
button. To edit the journal 
entry, click on the edit button.  
The entry’s account number, 

reference number, description, 
client number, job number, and 
vendor number can be changed.  
If the journal entry is posted, 
only the description  can be 
changed.  An entry’s  date can’t 
be changed, whether or not 
the entry has been posted.  To 
change the distribution of a 
journal entry’s amount, click on 
the edit amounts button.  You 
can edit the amounts by simply 
typing in the new amounts over 
the old ones, but the total deb-
its must equal the total credits 
or else your changes won’t be 
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saved. To delete a journal entry, 
click on the delete button.  
Only unposted entries can be 
deleted.  (Once a journal entry 
is posted, it can’t be deleted--
however, adjusting entries can 
be made to reverse it or it can 
be unposted.)  Journal entries 
are deleted by transaction, not 
by individual entry, to prevent 
unbalanced entries.  

3  Click on the print reports 
button to print journal reports 
and audit trails. 

The General Ledger window displays journal entries from A/P, A/R, the Checkbook, 
and Client Payments as well as manual entries you’ve made directly into the G/L.  
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4  The verify button checks 
the accuracy of the currently-
displayed G/L transactions. 
Clients & Profits analyzes the 
transaction’s journal entries 
for one-sided entries, missing 
entries, entries without a valid 
G/L account, Suspense account 
entries, and other typical data 
errors—then automatically 
makes the appropriate fixes.

5  Enter in the reference 
number here to find a journal 
entry.  Use the find more link to 
find journal entries by refer-
ence number, account number, 
date, date posted, amount or 
sequence.

6  Use the history pop-up menu 
to jump to a previously viewed 
journal entry.    
 
7  The journal entry’s source 
indicates where the transac-
tion was posted from —either 
General, Purchases, Sales, 
Cash Disbursements, or Cash 
Receipts.  

The General Ledger window 

8  The entry date is the invoice 
date on payables and receiv-
ables, the check date on checks 
or client payments. 

9  The reference number identi-
fies each transaction. Reference 
numbers that begin with either 
AP#, AR#, CK#, or PMT# were 
posted automatically; all other 
reference numbers were added 
by users directly into the Gen-
eral Ledger.  

10  Every entry is identified by 
its kind: user entry (which is 
most common), auto-reversing, 
recurring, or adjusting entry.  

11  Every transaction can con-
tain a full description for better 
accountability.  

12  The accounting period is 
used during posting to update 
the fiscal period’s account bal-
ances and reports.

13  The date posted shows 
when the transaction was 
posted. Each journal entry 

When editing one journal entry’s reference number, be sure to change it on the other 
entries in a transaction.  Since entries are shown by reference number, entries with 
different numbers won’t appear together.

shows the initials of the person 
who added it.  Entries within 
the same transaction can have 
different added by initials if two 
different people worked on the 
entry. 

14  The window shows each 
debit and credit journal entry 
for a transaction.  Entries are 
sorted by the order in which 
they were posted.  

15  The total debits and credits 
appear at the bottom of the 
window to easily spot out-of-
balance entries.
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Profit Centers

Profit Centers

Profit centers let you track the financial performance of different parts of your 
business without maintaining a separate set of books. Each profit center has 
its own chart of accounts. Every account can belong to a profit center, but it 
is not required. Profits centers are part of the Chart of Accounts.

Profit centers are used primarily for printing financial statements. Income 
statements, trial balances, balance sheets, and other financials can be print-
ed for one profit center or all profit centers. Printing financials for one profit 
center shows only the accounts that have the selected profit center number. 
Printing financial statements for all profit centers will show all accounts, 
whether they have a profit center number or not. You can also print budgets, 
detailed general ledgers, and analysis reports by profit center.

■ Profit centers aren’t required, and have no other affect on the General 
Ledger.

Profit centers can also be added to clients, jobs, tasks on the Task Table, 
and staff members. Whether a client, job, task, or staff member has a profit 
center doesn’t affect the General Ledger; the G/L is only updated from debit 
and credit accounts. Instead, having profit centers on clients, jobs, tasks, 
and staff members gives you more flexible and insightful production and job 
accounting reports.

The profit center isn’t needed when adding invoices and other entries.  Since 
the G/L account knows its profit center, all you need to enter is the right 
account number.  This also lets you move accounts between profit centers as 
needed without making time-consuming adjusting journal entries.

Customizing the Word 
“Profit Center”

The word “profit center” is custom-
izable as part of your Preferences. 
It can be changed to “department”, 
“office”, or any term you use to 
identify different parts of your 
business. To rename the words 
“profit center,” choose Preferences 
from the Setup menu, then choose 
Names from the pop-up menu. En-
ter the new term for “profit center” 
over the old then click Save. Once 
saved, the new name will appear 
everywhere the words “profit 
center” are used.

Assigning  a Profit Center  

A profit center can be assigned to 
G/L accounts, tasks, job tickets, 
and staff members.

■  Adding a profit center to a G/L 
account:   The profit center is in-
dependent of the account number.  
The account number doesn’t have 
to be changed to move an account 
into a different profit center.  
Any account with a profit center 
selected belongs to the entire 
company.

■  Adding a profit center to a task in 
the Task Table:  Any task can be as-
signed a profit center.  When a job 
is opened, it can be given a profit 
center; once saved, only tasks that 
belong to the job’s profit center can 
be added to that job.

■ Adding a profit center to a job 
ticket:  When a new job is opened, 
the profit center is copied from the 
client automatically. If the client 
doesn’t have a profit center, then 
the job’s profit center is blank. 
Once a job is saved, its profit center 
can be edited in the Specs window. 
If a job has a profit center, only 
tasks that also belong to the same 
profit center can be added to the 
job.

■ Adding a profit center to a staff 
member:  Although a staff member 
can have a profit center, he or she 
can still work on any job. Also, a 
staffer’s profit center number has 
no affect on their access privileges. 
It’s strictly an option field that’s 
useful for sorting staffers on custom 
reports.
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To set up a profit center, you will add a unique set of G/L accounts.  The account num-
bers can include the profit center number to distinguish them from the other accounts.

1  Click on the add button to 
add a new profit center.  You 
can add as many profit centers 
as you need. 

2  To print a hard-copy of the 
profit center list, click on the 
print button.  

3  Each profit center is identi-
fied by a user-defined code 
which has a maximum of 10 
letters or numbers.  

4  The description is the name 
of profit center.  The description 
will appear on printed reports 
and financials.
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1  Departments can be easily 
added, edited, or deleted at 
any time using these toolbar 
buttons.  To print a hard-copy 
list of departments, click on the 
print button.

2  Clicking on a column head-
ing sorts the department list. To 
edit a department, double-click 
on a department name.

3  Each department has a 
unique number from 1 to 99. 
When a G/L account is added 
for a department, its number 
is appended to the account 

number (e.g., 101000.10). 

4  The department name is a 
short description, or nickname, 
of the department.

5  Each department can have 
an optional description that 
explains 
its purpose or function. 

6  The initials of the depart-
ment manager are used by 
C&P Mail. Each day, Clients & 
Profits’ TimeCop feature checks 
the previous day’s time cards 
and time sheets, comparing 

Departments

each staff member’s planned 
hours with their actual hours. If 
a staff member hasn’t entered 
enough hours, the C&P TimeCop 
automatically e-mails a gentle 
reminder (or not-so-gentle, 
since it can be customized by 
the system manager). A copy of 
the message is sent to the staff 
member’s department manager. 
If the department doesn’t have 
a manager’s initials here, no 
copy of the message can be 
e-mailed.

7  The optional office field 
indicates in which office the 
department exists.

The same department table is used for G/L accounts as well as for users/staff mem-
bers (e.g., Admin, Acct Serv, Creative, Pub Rel, On-line, Pre-Press, etc.)

y u
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Subclasses
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1  Subclasses can be  added, 
edited, or deleted at any time.  
To add a subclass, click on the 
add button.  To change the 
number or name of a subclass, 
click on the edit button.  To 
delete a subclass, click the 
delete button.

2  Subclasses are identified by 
a number.   The number can be 
up to three digits long.  

3  The description is the name 
of the subclass.  It appears on 
the financials.  Some common 

Subclasses make your financial statements easier to read by sorting and subtotaling 
G/L accounts together that have the same kind of function. 

names of subclasses include:  
current assets, fixed assets, cur-
rent liabilities, and long-term 
liabilities.   Many shops also 
subclassify income and job cost 
accounts; Product Sales and 
Service Sales, for example. 

Subclasses
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ability, and equity accounts appear on the Balance Sheet. Income (billings), 
costs, expenses, other income, income taxes, and other expenses appear on 
the Income Statement. All 
accounts appear on the Trial 
Balance and the Detailed 
General Ledger. The classes 
themselves are preset, but 
their names can be changed 
in Preferences.

Accounts are subtotaled 
within each class using a 
subclass. Subclasses 
are optional and user-
defined, so you can create 
as many as needed.  An 
account’s subclass can be 
edited anytime. Each account can belong to one profit center and one depart-
ment. Profit centers are user-defined, so you can create as many as needed. 
Financial statements can be printed for one profit center at a time, or all 
profit centers.

Default accounts

Clients & Profits X has the ability to preprogram standard, or default, ac-
counts into your database. These default accounts are entered automatically 
when payables, checks, receivables, and client payments are added. Default 
accounts can be overridden by simply entering an account number when 
a transaction is added. Default account numbers can be entered for these 
accounts: Cash/Checking; Accounts Receivable; Accounts Payable; Client 
Retainers; Billing/Income; Employee Advances; Media Accruals; 
Media Costs; Overhead Expenses; Retained Earnings; Advance Billings; A/R 
Discount Given; A/P Discount Taken. Default G/L accounts are optional, but 
can help make your accounting more consistent and reduce errors. The de-
fault account numbers are entered in the G/L accounts Preferences window.             
             

Active/inactive accounts

Accounts marked inactive do not appear on the lookup list and cannot be 
entered on transactions. To mark an account as inactive, highlight the ac-
count in Chart of Accounts, click the Edit button, then uncheck the account’s 
active checkbox.

Rollup account only

Accounts which need to be hidden on financial statements can roll up into a 
designated account (marked as “Rollup account only”) when a statement is 
printed. Roll-up only accounts can not have entries added to them and don’t 
carry a balance. To set up a rollup account, highlight the account in the Chart 
of Accounts, click the Edit button, then select the rollup account only option. 

Chart of Accounts

The Chart of Accounts contains your G/L accounts. These accounts are the 
basis of your accounting system, keeping monthly totals of income, costs, 
expenses, assets, and liabilities. The balances that appear on income state-
ments, balance sheets, trial balances, and other financials are based on the 
account totals in the chart of accounts.

The Clients & Profits X chart of accounts is completely customizable. You 
can have as few or as many accounts as you need (there’s no real limit to the 
quantity of accounts). Each account has an account number, classification, 
subclass, and categories for cash flow and ratio reports. Separate accounts 
can be set up for different profit centers and departments. Every account 
keeps real-time running balances for up to 24 accounting periods in Clients 
& Profits Pro X and C&P SQL X, 15 accounting periods in Clients & Profits 
Classic X, and 12 accounting periods in Job Tracker X. 

Budget amounts can be quickly set up for any or all accounts and periods 
using last year’s totals. Account totals can roll up into other accounts. The 
accounts are set up with the rollup information in the Chart of Accounts. 
Choose the rollup option when printing financials to rollup, or hide, the 
account totals in the designated account. Accounts can also be made 
confidential. Confidential accounts work like regular accounts, but can’t be 
used by non-managers. They don’t appear on the printed account list or the 
lookup list.

You can add, edit, and delete accounts from your Chart of Accounts anytime 
(except for accounts with activity). Accounts with activity can be edited 
(except the number) and reclassified, but not deleted.

Account numbers

There are no rigid rules about numbering G/L accounts, although the number 
has a limited length (11-digits, including a 2-digit department number). You 
choose your own account numbers, so you can use any numbering system 
that conforms to accounting standards. Also, the same account number can’t 
be used twice. Account numbers are numeric, so they can’t contain letters 
or characters (i.e., dashes, etc.). An account number can’t be changed if the 
account has activity (i.e., journal entries) or a balance. Account numbers can’t 
contain leading zeros (e.g., 001000).

Account classes, subclass-
es, and profit centers

Accounts are categorized three ways: 
a major class (e.g., asset, liability, 
sales, etc.), a subclass (e.g., current 
assets, fixed assets, etc.), and a profit 
center. The class organizes accounts 
as assets, liabilities, equities, sales, 
costs, expenses, other income, income 
taxes, or other expenses. Asset, li-

Chart of Accounts
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Confidential accounts

Accounts can be made confidential for privacy. Confidential accounts func-
tion like other G/L accounts, but can’t be used by non-managers. Commonly-
used accounts, such as a checking account, shouldn’t be confidential since 
many users need them. Typically confidential accounts would track such 
accounts as employee bonuses, executive loans, and stock options.

Cash Flow and Ratio categories

A Statement of Cash Flows report, as well as a set of ratio analysis reports, 
can be printed any time from 
Financials. The cash flow 
and ratio categories are 
optional fields which enable 
you to print these powerful 
accounting reports. The cash 
flow category assigns the 
account to a category used 
in calculating the Statement 
of Cash Flow Report. The 
ratio category assigns the 
account to a subclass which 
is used in ratio analysis in 
the Financials menu. 

■  To assign cash flow or 
ratio categories, highlight the account in the Chart of Accounts then click the 
Edit button. Then choose a category from the pop-up menu:

Year-to-date net in-
come, retained earn-
ings 

The Year-to-Date Net Income 
and Retained Earnings accounts 
are necessary to your financial 
statements. The year-to-date 
net income account (which is 
always 999999) is calculated 
each time a financial state-
ment is printed. The account’s 
balance is always the income 
less costs and expenses. While 
the account number can’t be 
changed, you can name the 
account whatever you want. You 
can’t post entries directly to the 
YTD income account; instead, 

entries should be posted to income, costs, expenses, or Retained Earnings.

The Retained Earnings account tracks net income (or loss) from the previous 
accounting years. It’s an equity account of your choosing. The account is only 
used at year-end closing and for adjustments. Unlike the year-to-date net in-
come account, you can post journal entries to the Retained Earnings account 
when you need to adjust last year’s ending balances.

The suspense account

The suspense account (999998) is updated when the program isn’t able 
to find the account entered on the transaction. It’s an important account 
because it acts as a safety net when the wrong account, or no account, is 
entered. When entries are found in the suspense account, they are reversed 
out of suspense and into the correct account.

Chart of Accounts
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Once accounts are set up in the Chart of Accounts, their properties can be edited.  
This flexibility allows you to customize the appearance of your financial statements.

Chart of Accounts

1  G/L accounts can be added, 
edited, budgeted, or deleted 
from the Chart of Accounts 
window.  To add a new G/L ac-
count, click on the add button.

2  To edit a G/L account’s infor-
mation, click on the edit but-
ton.  An account’s budget can 
be added, edited, viewed, or 
deleted by clicking on the edit 
budget button.  The Monthly 
Budget window shows you the  
monthly totals for this year and 
last year, as well as the budget 
for the selected G/L account. To 

delete an account, click on the 
delete button.  If an account 
has a balance or journal entries 
posted against it, it can’t be de-
leted.  Instead, you can  make 
the account inactive.

3  To print a hard-copy of the 
account list, click on the print 
button.  The list shows each 
account’s  number, name, class, 
subclass, and profit center.

4  Enter an account number 
here to find a G/L account.  

5  Clicking the view history link 
let’s you quickly view and print 
all G/L entries for a selected 
account.  All periods with activ-
ity appear and the debits and 
credits are subtotaled.  Then 
the period is reported.  The 
account’s balance is calculated 
at the end of the report.  Each 
transaction’s date, reference 
number, and description are 
also given.   

6  Profit centers, subclasses, 
and budget worksheets can 
be added, edited, viewed, and 

The Chart of Accounts window
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deleted from the Chart of Ac-
counts window.  Clicking on the 
profit centers link opens the 
Profit Centers window, where 
you can add, edit, and delete 
PCs.  Profit centers are used 
to track the financial perfor-
mance of different parts of your 
business without maintaining 
a separate set of books.  Click 
the subclasses link to add, 
edit, delete, and print account 
subclasses. Subclasses are 
used to arrange and subtotal 
accounts on financial state-
ments. Examples of standard 
subclasses are Current Assets 
and Long-Term Liabilities. An 
account can belong to any (but 
only one) subclass.  Click on 
the budget worksheet link to 
enter or edit the budget for the 
year.  All the G/L accounts and 
periods are displayed.

7  Double-click on the account 
class to view its accounts. G/L 
accounts are listed numerically 
by account number with their 
name/description, profit center, 
and subclass.    

Chart of Accounts

Monthly budget amounts for a selected account can be reviewed on-line by clicking 
on the edit budgets button.  This window also compares budgets with actual totals for 
th current fiscal year.  

8  Double-clicking on an ac-
count lets you change the G/L 
account information, such as its 
name. G/L accounts are added, 
edited, or deleted in the Chart 
of Accounts window only. 

9  The name of the G/L account 
appears here for easy reference.
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The Add New Account window
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1  The account number can 
contain up to 6 digits plus a 
2-digit dept. number. They’re 
customizable, but can’t be 
changed once the account 
has a balance.

2  Active accounts appear 
everywhere. Making an account 
“inactive” prevents it from be-
ing used for new work.  Inactive 
accounts will appear in the 
Chart of Accounts window and 
the lookup list with an “*” next 
to it.

3  The account name is a short 

description of the account’s 
purpose. 

4  Each account belongs to a 
class (e.g., assets, liabilities, 
etc.).  The class is used to 
organize accounts and deter-
mines what accounts are on 
the Balance Sheet and Income 
Statement.

5  An optional subclass can be 
used for making subtotals on 
financial statements. 

6  An account can belong to 
a profit center by entering its 

number here. 

7  An account can belong to 
a department by entering its 
number here. The dept. number 
is appended to the account 
number, so it can’t be changed 
if the account has a balance. 

8  Several like accounts can be 
combined together by entering 
a roll-up account here. When 
financials are printed with the 
roll-up option, only the roll-up 
accounts will appear. It’s an 
easy way to print consolidated 
reports. 

d

New accounts can be added to the Chart of Accounts any time during the fiscal year.  
Once an account is added, it’s available to anyone in the agency to see and use it.
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For checking accounts only, the next check number appears in the Edit Account win-
dow in Chart of Accounts.  You can have as many checking accounts as necessary and 
each account tracks its own check numbers.

9  The description explains 
where, when, and how an 
account should be used. It’s 
a great way to document your 
accounting procedures. 

10  Roll-up only accounts are 
used for display purposes 
on financial statements, and 
are only used for printing. 
They can’t be used otherwise. 
Confidential accounts are only 
available to managers, and 
can’t be seen or used by regular 
users. They are typically used 
for hiding private or controver-
sial accounts (like profit sharing 
for officers, etc.) from lookup 
lists and accounting reports. 

11  Any vendor payable or client 
receivable account should be 
marked as a control account. 
They are used by the Auditor to 
verify that aging reports equal 
the balance sheet.

Adding G/L Accounts

12  Only accounts marked as a 
checking account can be used 
for check writing. Each account 
has its own check numbering 
series. The starting (or current) 
number is user-defined to 
match your check forms.

13  The cash flow category is 
used to sort an account properly 
on the Cash Flow report. The 
ratio category is used by the 
financials to calculate business 
ratios. 
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The Budget Worksheet window

1  The revert button erases any 
unsaved changes, then displays 
the last-saved budget work-
sheet. Click the clear button to 
delete budget —or all periods—
for the currently selected G/L 
account.

2  The auto-calculate function 
automatically calculates the 
account’s annual budget based 
on last year’s actual totals. If 
the previous year’s account 
totals are accurate, this is good 
shortcut.

3  Clicking the copy button 
copies the currently selected 
account’s budget amount to all 
other periods.

4  Click the bump button to 
increase an account’s budget by 
any percentage.

5  Click the print button to print 
the budget worksheet.

6  Clicking the export but-
ton creates a spreadsheet-
compatible text file of your 
G/L accounts and their budget 
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amounts. This text file can be 
opened by Microsoft Excel. The 
budget amounts can be edited 
in the spreadsheet, then saved 
back into a text file (this is 
important—don’t save it as a 
regular spreadsheet file). Once 
saved, those budget amounts 
can be imported into Clients & 
Profits.

Clicking the import button 
brings the budget amounts from 
the text file back into Clients & 
Profits. Importing replaces any 
budget amounts currently in the 

p

The Budget Worksheet is an excellent tool to use in the new year because you can 
calculate the budget automatically based on last year’s totals. 
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Budget Worksheet with the ones 
you’ve edited in the spread-
sheet program.

7  Budgets can only be edited 
for one fiscal year at a time. 
This heading shows which fiscal 
year is selected.

8  Choosing a profit center 
from the show pop-up menu 
shows only those accounts that 
belong to the profit center. It 
lets you easily work on budgets 
for one profit center at a time. 
Once you’ve entered the profit 
center’s budgets, you must click 
Save; otherwise, the budget 
amounts won’t be saved.

9  The filter pop-up menu 
shows only accounts for a 
selected class (e.g., Income ac-
counts only), which can simplify 
budgeting when there’s a large 
number of accounts.

Each G/L account can have monthly budgets for each of the 24 accounting periods 
of both fiscal years.  These budgets can be compared with actuals anytime during a 
month by printing the Budget vs. Actual financial report in Snapshots.  

10  Budget amounts are en-
tered for each G/L account and 
each accounting period. A bud-
get amount for every account or 
every accounting period is not 
required.
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1  The entry date shows when 
a journal entry was added. New 
journal entries are automatically 
given today’s date, which can 
be changed. The date doesn’t 
affect the G/L, since the ac-
counting in Clients & Profits is 
based on periods.

2  Reference numbers are used 
to identify journal entries, like 
an invoice number. Journal 
entries are numbered auto-
matically from your accounting 
preferences, but are flexible. 
You can change the reference 

number by entering any com-
bination of letters or numbers. 
Even the prefix “JE#” can be 
changed. 

3  Any unlocked period can be 
chosen from the period pop-up 
menu.  

4  The auto-reversing option 
automatically creates reversing 
debit and credit entries into the 
next accounting period (i.e., 
the debit entry is reversed as 
a credit entry, and vice versa).  
Auto-reversing entries keep 
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you from forgetting to back 
out entries such as month-end 
accruals.

5  By checking the recurring 
option, the same transaction 
will be repeated in up to 23 
periods.   This option saves you 
from having to rekey the same 
depreciation, amortization, etc. 
entries each month.  Recur-
ring entries can’t be scheduled 
into locked accounting periods.  
Recurring entries aren’t posted 
until the month for which they 
are scheduled is the current 

The Add Journal Entries window

Manual journal entries can be added any time during the month for all kinds of miscel-
laneous entries such as: payroll, insurance expenses, bank fees, interest income, etc. 

Adding JEs

a
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period.  They can be seen on 
the proof list by checking the 
“include  recurring entries” 
option.  

6  The optional description will 
appear on audit trails, journals, 
and detailed G/L reports to 
explain anything about the 
transaction. It can be changed 
on a specific JE later by double-
clicking on an entry in the G/L 
window.

7  Enter each journal entry’s 
G/L account number here.  If 
you’re not sure about a G/L 
number, leave the field blank 
then press Tab.  The Chart of 
Accounts lookup list opens, 
displaying your G/L accounts.  
Double-clicking on an account 
enters it onto the journal entry.

8  The G/L account’s name is 
shown for quick reference.

Every journal entry can contain a client number, job number, and vendor number.  This 
information is used for printing audit trails and journals, but has no affect on client 
balances, job totals, or vendor balances.

9  Every journal entry can be 
given a job number. Journal 
entries don’t affect the job 
ticket directly; instead, you’d 
only enter a job number here if 
this amount should affect the 
Client P&L reports. You should 
only enter a job number here 
if you’re allocating overhead 
expenses directly to a job or a 
client. When you enter a job 
number, its client number is 
copied automatically to this 
journal entry.

10  Each journal entry needs a 
debit or credit amount.

11  The total of the debits and 
credits must equal or the trans-
action won’t be saved.
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Printing G/L Reports

Printing G/L Reports

G/L reports show journal entries from the General Ledger. They do not show 
time entries, out-of-pocket job expenses, or purchase orders (since these 
entries don’t directly affect the G/L). Instead, they show the entry-by-entry 
detail for the account totals shown on financial statements.

Since journal entries include both a date added and a date posted, G/L 
reports can be printed showing entries either added or posted for any time 
period (e.g., today, last week, the 
entire month or year, etc.). 
A journal entry can have an op-
tional job number, client number, 
and vendor number, which can 
be used to select entries for the 
Audit Trail reports. Job, client, 
and vendor numbers are auto-
matically included on JEs posted 
from A/P, A/R, checkbook, 
client payments, and employee 
expense reports. They can be 
entered manually on general 
journal entries. Audit trails can 
be printed showing only those 
entries added for a particular job, 
client, or vendor number. 

Clients & Profits prints three 
kinds of G/L reports: journals, 
audit trails, and analysis re-
ports.  While audit trails and journals both 
show G/L entries, they have distinctly 
different purposes. Which one you’ll 
print depends on just what you need 
to see. 

Audit trails are used to see the detailed 
entries that comprise your G/L account 
balances. They show JEs totaled by G/L account, while journals show entries 
grouped by reference number. This makes audit trails best for reviewing an 
account’s activity (especially to see how an account balance really adds up). 

Journals are most useful for reviewing the debits and credits for each transac-
tion. They show what you’ve entered into the G/L, transaction-by-transac-
tion. Journal entries are sorted by reference number for easier auditing. Each 
journal entry shows its account number, date, description, period, and debit 
or credit amount. Journals can be printed for all kinds of transactions, or for 
only general ledger, payables, receivables, checks, and client payments.  

Analysis reports list specific types of journal entries: clearing, recurring, auto-
reversing, adjusting and auto-WIP entries. 

■  Audit trails, journals, and analysis reports can be printed to the window, 

instead of the printer, for a quick review of your work. The print to option 
automatically prints all reports to the screen. To print a report to the printer, 
simply choose Printer from the pop-up menu. To export the report to a 
spreadsheet, choose Export from the pop-up menu; you’ll be prompted to 
name the report, which will be saved to your hard disk as a file. To copy the 
report to the clipboard choose Clipboard from the pop-up menu, then you can 
paste the report into a spreadsheet program like Excel.

To print a journal

1  From the General Ledger 
window, choose File > Print G/L 
Reports. 

2  Click on the “Journals” label.

3  Enter your report selections, 
including a range of dates, peri-
ods, and account numbers.

4  Choose a journal report by 
clicking on a report name.

5  Click Print.

To print an audit trail

1  From the General Ledger win-
dow, choose File > Print G/L Reports. 

2  Click on the Audit Trail report option.

3  Enter your report selections, including a range of dates, periods, and ac-
count numbers. Audit trails can be printed for a specific job, client, or vendor 
by entering and ...and for value (i.e., a job number, client number, or vendor 
number). If entered, only journal entries for that job, client, or vendor will be 
printed, then click Print.

To print an analysis report

1  From the General Ledger window, choose File > Print G/L Reports. 

2  Click on the “Analysis” label.

3  Enter your report selections, including a range of dates, periods, and ac-
count numbers.

4  Choose an analysis report by clicking on a report name, then click Print.

Print for any period. G/L 
reports can be printed for 
any one of the 24 accounting 
periods, as well as for a range 
of selected periods (e.g., 
periods 1-6) using the and 
period menu.
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General Ledger Reports

Report Name Description

Auto-Reversing Entries

Media WIP accrual entries

Recurring Entries

Adjusting Entries

Clearing Entries

General Journal

Purchases Journal 

Sales Journal 

Cash Disbursements Journal

Cash Receipts Journal

Audit Trail

JEs marked as auto-reversing entries post a reversing entry into the next period. Print 
the report by date range, period or range of periods and by account or range of ac-
counts.

WIP accrual entries are automatically created by the media buying system for tracking 
media work in progress. The accounts debited and credited, dates, and invoice num-
bers are reported for media accrual AP invoices and pre-billed insertion orders. They 
are posted by client media billings (i.e., broadcast and print media) from Accounts 
Receivable and the media accrual invoices from Accounts Payable. Together they 
properly account for media pre-billings by estimating the cost of the media. When 
the vendor’s final media invoice arrives, the actual media cost is reconciled with the 
accrual.

JEs marked as recurring entries are reported by date range, period range and account 
range. 

JEs entered as Adjusting JEs to balance a transaction are listed on this report. Print 
the report by date, period or account. 

This report lists the JEs posted from Transfer Account Balances in G/L Tools. The ac-
counts transferred from (cleared) and the accounts transferred to are listed. Print the 
report by date, period, and account.

Only manual journal entries (JEs) are reported in the General Journal. The report can 
be printed by period and date range. The debits, credits, G/L accounts, and date are 
listed. 

Accounts payable invoices (APs) are found in this journal. The debit for the cost or 
expense account, and the credit to the AP account, are reported along with their 
amounts. Print the journal for one day or a range of dates. Or print for one period, or 
for all periods.

Accounts receivable invoices (ARs) are reported by date range or period in this jour-
nal. Both the credit to the income account and the debit to accounts receivable are 
listed with the amounts.

All types of checks––vendor payments, direct disbursements, overhead checks––are 
listed here. See the credit and debit accounts and the amounts, listed in check 
number order. 

Client payments and bank deposits (PMTs) are reported in this journal. Use this report 
to audit which bank accounts were debited, whether the entries balance, and what the 
total receipts were for the period or date range entered. 

Audit an account’s entries, or print a range of accounts totaled account-by-account. 
The audit trail can be printed for a range of dates and periods. Print for a specific job, 
client, or vendor to see how it affects the account.
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Clients & Profits X provides a comprehensive set of tools to help manage 
your General Ledger. These timesaving utilities are easy to use, and prevent a 
lot of time-consuming manual work to audit, verify, and adjust your account-
ing. 

Anyone with access to the General Ledger can potentially use the G/L tools. 
Each tool has its own separate access privilege (see User Access & Pass-
words) for flexibility. This gives different users access to some G/L tools and 
not others. The G/L tools include:  

The Auditor

The Auditor is a collection of utilities to verify 
selected parts of your Clients & Profits X 
database. It lets you double-check your G/L 
account balances, A/R totals, A/P totals, 
and other files to ensure their accuracy. Each 
utility can be run independently, or all of the 
utilities can be run together.

Transfer Account Balances

A G/L account number can’t be changed once 
it has a balance. So what happens when you 
decide to reorganize your chart 
of accounts? One option is to wait until the 
year is closed, when all of the income, cost, 
and expense accounts are zeroed out. But 
what about asset, liability, and equity 
accounts that always keep their balances? 
That’s when you’d use the Transfer Account 
Balances tool. It lets you move an account’s 
balance to another account. It happens 
automatically, which simplifies the process and 
keeps it more accurate.

G/L Reconciliation

The task of auditing prepaid and accrual accounts is simplified with the G/L 
Reconciliation. It lists an account’s entries from the General Ledger. The 
entries are then marked as cleared. Once saved, the cleared items will be 
removed from the reconciliation window. A G/L reconciliation report can be 
printed to prove your Balance Sheet account balances. 

Add Adjusting JE

This tool lets you make up journal entries that weren’t posted with the 
original transaction, typically due to a system crash or some kind of network 
problem during posting. Normally, journal entries can’t be saved unless the 

General Ledger Tools

General Ledger Tools

Auditing tools and more. 
Each users can have dif-
ferent access privileges to 
the G/L tools. Each 
tool has its own user 
access privilege, giving 
managers very specific 
control over who can run 
them.

transaction’s debits equals its credits. It should only be used to fix a one-
sided entry. Otherwise, the entries you make with the Add Adjusting JE tool 
will make your financials out of balance. 

Import Payroll

If you produce your own payroll checks using the CheckMark Payroll soft-
ware, payroll data can be imported into Clients & Profits X. CheckMark has 
the ability to export payroll information into a standard text file. Clients & 

Profits X then imports this text file into the 
General Ledger as an unposted payroll journal 
entries.

■  For more information on CheckMark Pay-
roll, contact CheckMark at www.checkmark.
com or (800) 444-9922.

Overhead Allocation Worksheet

This tool calculates each client’s share of the 
agency’s overhead expenses for any selected 
month. The overhead allocation worksheet 
adds up the hours worked by each staff 
member, then allocates a proportion of the 
overhead expenses to each client based upon 
the specific method. The worksheet lets you 

enter the month’s payroll totals for each employee, which then becomes part 
of the client’s overhead allocation. The client overhead totals are then used 
on the Client P&L Analysis report (see Financials).

Close Year

Clients & Profits X can handle two open fiscal years, for a total of 24 ac-
counting periods. So while there’s no real urgency to close the first year, at 
some point it’s necessary. Year-end closing is very easy and mostly auto-
matic—Clients & Profits X handles everything. Once you’ve entered the year’s 
remaining entries, you’ll run the Close Year procedure. It presents a checklist 
of steps it goes through to close out the fiscal year. Once you’ve started the 
close year process, it runs unattended until it finishes. Afterwards, you can 
print a log of steps completed by the Close Year tool.
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At month-end, or at any time as needed. The Auditor features several utilities for audit-
ing different job and accounting data files. It lets you run one utility, all utilities, or any 
number of utilities at one time. When you suspect a specific problem, the Auditor helps 
you troubleshoot the cause and, in most cases, will solve it.

As needed when one account needs to be merged with another. 

At month-end, or whenever adjusting entries need to be made to prepaid expense (such 
as insurance), amortization, and depreciation accounts.

As needed to fix a one-sided (or otherwise unbalanced) G/L transaction. The Add 
Adjusting Entry tool lets you add back in missing items caused by system crashes or 
freezes during posting. 

Each time a payroll is made.
 
At month-end. The overhead allocation worksheet calculates overhead expenses for 
each client based on the hours worked during a month. It uses payroll totals for each 
employee that worked during the month, so it shouldn’t be run until the month’s payroll 
is paid. You can run the overhead allocation worksheet without payroll numbers, but the 
report will only show direct job costs -- but no labor cost.

At year-end, as soon as all of the year’s work has been posted. Since Clients & Profits 
supports 24 accounting periods (two fiscal years), the year doesn’t have to be closed 
until well into the next year (after your year-end adjustments from your accountant are 
posted). 

General Ledger Tools

The Auditor

Transfer Account Balances

G/L Reconciliation

Add Adjusting JE

Import Payroll  

Overhead Allocation Worksheet

Close Year

Using the General Ledger Tools

Tool name When to use it 
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Importing Payroll

Because of its frequent revisions, Clients & Profits X doesn’t handle payroll 
accounting directly. Instead, it works with a payroll program called Check-
Mark Payroll by CheckMark Software. 

CheckMark is a stand-alone system that tracks employees, deductions, and 
other payroll issues apart from Clients & Profits X. Information about your 
payroll, however, can be extracted from CheckMark Payroll on a monthly 
basis then imported into Clients & Profits. 

Importing payroll eliminates 
entering payroll records twice, 
so it saves time. Your payroll 
costs are imported, verified, 
then saved as unposted journal 
entries. You can then proof these 
payroll entries just like other 
journal entries, make changes, 
then post them. Posting updates 
your payroll and cash balances 
on your financial statements.

Since Clients & Profits X and 
CheckMark Payroll are not actu-
ally linked, you’ll need to make 
sure your G/L accounts are the 
same in both programs. Payroll 
entries exported from Check-
Mark 
get a G/L account number, 
which 
is verified when the data is imported. 
If the account number is wrong for 
any reason, the journal entry will be 
saved into Suspense—and should be 
changed before it is posted. 

■  For more information on CheckMark 
Payroll call (800) 444-9922 or see their 
web site: www.checkmark.com.

To export your payroll data from CheckMark Payroll

1  From the CheckMark Payroll program, Choose Reports > Check Informa-
tion.

2  Select the correct month.

3  Highlight the payroll checks to be included in this journal entry.

4  Select Posting Summary.

5  Choose M.Y.O.B. from the text file format pop-up menu. 

Importing Payroll

 
6  Click on the Text button to export the payroll summary data.

7  Name the text file something like 11/04 Payroll then click OK.

This text file, containing your payroll entries, will be saved to your hard drive. 
Now it is ready to import to Clients & Profits.

8  Quit CheckMark Payroll.

To import your payroll 
data into Clients & 
Profits

1  Choose Accounting > General 
Ledger 

2  Choose Edit > G/L Tools > 
Import Payroll.

The Import Payroll window 
opens, prompting you to enter 
an accounting period. 

3  Enter an accounting period.

The accounting period is used 
by the payroll entries to update 
your financial statements. Your 

current accounting period is entered automatically, but can be changed. Any 
unlocked period can be used.

4  Click Import.

You’ll be prompted to find the payroll text file. Any kind of text file will appear 
in the Import dialog box, so be careful to select the right text file.

You’ll then be prompted to open your payroll text file.

5  Select your payroll text file, then click OK.

Your payroll entries import one after another (you’ll see the record count as 
they’re imported). 

■  If the text file isn’t tab-delimited, you’ll get an error message. Payroll text 
files must be tab-delimited. 

Once imported, the G/L account number of the entries is verified. If an 
account on the payroll entry doesn’t exist, the entry will be posted to the 
Suspense account (#999998). You’ll see these entries on the proof list; they 
should be fixed before they are posted.

Exporting payroll. The Post-
ing Summary report contains 
accounting data from a 
month’s payroll checks. Be 
sure to change the text file 
format to M.Y.O.B to properly 
export your payroll data.

Need more info about payroll? Get a list of frequently-asked ques-
tions from www.cnp-x.com/support/FAQs
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Importing payroll. Ac-
counting data from payroll 
checks is exported from 
CheckMark as a text file. 
This file, which contains 
the date, account number, 
and payroll amount (but 
not the staff name or 
salaries), is imported as 
unposted journal entries. 
Once the data is imported, 
you can proof it, make 
changes, then post the 
entries.

■  Be very careful not to import that same payroll text file more than once. If 
so, your payroll entries may be posted twice. For security, trash (or otherwise 
file away) your payroll text files once they’ve been successfully posted.

■  Any payroll entry that has the G/L account of #999998 had an invalid ac-
count, and should be fixed. Don’t post these entries until they’re correct. 



7-32

Transfer Account Balances

Transfer Account Balances moves a G/L account’s balances, from a selected period, to another account. This tool 
is helpful if you decide to reorganize your chart of accounts by renumbering some accounts or need to combine 
two accounts. A journal entry is automatically created for each accounting period in the date range selected. The 
journal entries reverse the balances from the original account and distributes them to the new account. A log of 
the unposted journal entries is automatically printed. The unposted entries should be proofed and then can be 
posted through the General Ledger.  

Transfer Account Balances

1 Enter in the G/L account 
number that you are transfer-
ring balances from.  

2  Enter in the G/L account 
number that you are transfer-
ring the balances to.

3  Choose a range of accounting 
periods from the period pop-up 
menus.

4  When you click on the ok 
button, a log of the unposted 
journal entries will be printed.  
This proof list needs to be care-

fully reviewed and compared 
to the YTD Trial Balance before 
posting the entries.  Once 
posted, the original account’s 
balances will be zero and the 
new account will reflect the 
balances.

The Transfer Account Balances doesn’t move the actual activity from the original ac-
count to the new account.  Instead, just the balances are transferred via the journal 
entries. 
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Add Adjusting JE

The Add Adjusting JE window lets you make one-sided, unbalanced journal entries into 
your G/L. Journal entries otherwise can’t be added without being in balance.  

Add Adjusting JE

1  Enter in the adjusting journal 
entry’s G/L account number.  
Usually, this is the account that 
is causing the out of balance

2  Enter in the accounting pe-
riod that the adjusting entry will 
be posted to.  Usually, it should 
be the same accounting period 
as the original transaction.

3  Enter in the date of the ad-
justing journal entry.  It can be 
the date of the original transac-
tion or today’s date.

4  Enter in the reference 
number.  It must be the same 
number that was entered onto 
the original entry.  If not, the 
adjusting entry won’t appear 
together with the original jour-
nal entry.  

5  Enter in an optional de-
scription to explain why the 
adjusting journal entry is being 
added.

6  Enter in the job number, 
client number, and/or ven-
dor number for the adjusting 

journal entry.  These fields are 
optional.

7  Enter in the adjusting journal 
entry’s debit or credit amount.  
This should be the amount for 
which the original transaction is 
out of balance, otherwise you’ll 
still be out of balance.

8  Clicking on the save button 
will add the adjusting entry to 
the original journal entry as an 
unposted entry.  
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G/L Reconciliation

1  Click the Print button to print 
the list of outstanding items.

2  This is the account you’re 
currently reconciling. Each ac-
count is reconciled separately.

3  The list shows all year to 
date entries through this ac-
counting period.

4  A description of the entry is 
displayed from the journal entry 
for reference.

5  Depending on the G/L ac-

count reconciled, the Vendor 
or Client codes appear here for 
reference.

6  Uncleared entries are listed 
for the G/L account. Entries are 
sorted by vendor or client. You 
can sort the entries differently 
by clicking on the date, refer-
ence, period, or description col-
umn headings. The checkbox is 
marked if an item has cleared.

7  The reconciled balance is the 
total of the uncleared items. 
The G/L balance is the account 

balance from your balance 
sheet. It is the balance as of 
the accounting period selected.

8  The total debits and credits 
are totaled for the uncleared 
items.

G/L Reconciliation

The G/L Reconciliation allows you to audit your balance sheet accounts.  Also, it is 
precise - so your reconciled balance must equal the G/L balance or it can’t be saved.
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Out of Balance Checker

It’s possible for your general ledger to become out-of-balance because of 
system crashes during posting. This happens when one side of a transaction 
(either a debit or credit) is posted, but the system crashes before the other 
side is finished. The problem can happen at any time, and it is difficult to 
prevent (since it is always system related). For performance reasons, Clients 
& Profits doesn’t automatically warn you when you’re out of balance. But it’s 
easy to see if your G/L is out of balance: simply look at the bottom line of the 
Balance Sheet (it’ll show the out of balance amount), or at Total Assets, Li-
abilities, and Equity section on the 
Trial Balance (which should always 
be zero). 

The key to solving an out-of-
balance G/L problem is to find 
the missing (or duplicated) journal 
entries. Since all JEs for a particular 
transaction have the same refer-
ence number, it’s easy to track 
down the bad entries. To make 
troubleshooting your G/L easy, 
Clients & Profits provides a special 
Out of Balance Checker utility.

How the Out of Balance 
Checker works 

The Out of Balance Checker utility 
works by analyzing your G/L 
journal 
entries transaction-by-transaction. 
It 
adds up the total of each transac-
tion’s 
debits and credits (i.e., JEs with the same 
reference number), then highlights the 
ones that don’t balance. The Out of 
Balance report only shows the transactions 
that need fixing. 

■  The Out of Balance Checker only finds 
unbalanced entries that need to be corrected. 
It does not change your general ledger in any 
way. You’ll need to make your own judgments about how to correct an unbal-
anced entry (that is, making the appropriate debit or credit adjusting entry).

■  The total debits and credits for each reference on the Out of Balance 
checker report correspond to the total debits and credits in the G/L window 
for that transaction.

The total amount of the entries on the report should equal the out-of-balance 

amount on the Balance Sheet or Trial Balance. 

Verifying journal entries

A quick an easy way to fix an entry listed on the Out of Balance Checker re-
port is to use the Verify JE button.  It will verify the accuracy of the currently 
displayed journal entry, and will automatically fix any common problems 
that are causing the out of balance by adding adjusting je’s for you to proof 

and post.  If the source of the 
journal entry has a problem, the 
Verify JE button cannot fix the 
problem.  Instead it will tell you 
to correct the source.  The Verify 
JE button can be used on journal 
entries created from Accounts 
Payable, Accounts Receivable, 
Client Payments, Expenses, and 
the Checkbook.  Manually entered 
journal entries can’t be fixed by 
the Verify JE button.

To use the Verify JE button

1  Find the journal entry that 
needs to be verified.

2  Click on the  (i.e., Verify 
JE) button.

If a problem was found, then 
adjusting journal entries will be 
automatically created for you.  If 

no problem was found, then the message will tell you the journal entry has 
been verified.

Details of the out of bal-
ance entries are listed, 
including the reference 
number, date, accounting 
period and amount.  This 
information can be used to 
research why the entry is 
out of balance and how it 
should be corrected.  
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The Auditor

The Auditor performs automatic self-checks on your Accounts Payable, Ac-
counts Receivable, and General Ledger totals. It’s used for troubleshooting 
data entry and posting problems. Because it automatically double-checks 
account totals against the records that make them up (e.g., G/L account 
balances and their journal entries), it saves users from having to print and 
analyze hundreds of pages of reports to find accounting problems. 

How the Auditor works 

The Auditor works by double-checking the records in your A/P, A/R, and 
G/L data files. The complete auditing process includes checking for out-of-
balance G/L entries, making sure that the A/P and A/R agings equal the 
Balance Sheet totals, and ensuring that billable time entries contain a client 
number. Each auditing step has a different function, which is described 
below.

■  Everyone can keep working in Clients & Profits while the Auditor is work-
ing, and it can be canceled any time without damaging the database.

■  The Auditor can be run any time during the month, and as frequently as 
needed.

Also, don’t mistake the Auditor for a traditional accountant-based financial 
audit. The Auditor can only check the account totals themselves, ensuring 
that they add up correctly. It can’t make value judgement about how users 
have entered data (for example, it can point out that the wrong expense ac-
count was used). It doesn’t replace a professional accounting audit. Instead, 
it is only a useful tool for finding the source of accounting problems.

Auditing steps

All of the Auditor’s steps can be performed at the same time, or individual 
steps can be chosen to run independently. If time allows, all of the steps can 
be run together; however, if you suspect a specific problem that the Auditor 
can confirm and time is tight, you can choose to run only one step at a time. 

Out of Balance Checker This step points out one-sided or otherwise unbal-
ance journal entries from the General Ledger. If your Trial Balance shows an 
out-of-balance total, the Out of Balance Checker will show you precisely 
where the problem occurs. For more information on using the Out of Balance 
Checker see page 7-35. 

Account Totals Checker This utility compares totals on your financial state-
ments to the journal entries in your general ledger.

AP Quick Check This report compares the total of your vendor aging to the 
total of a/p control accounts designated under Setup>Chart of Accounts. This 
is a quick way to make sure your agings stay in balance.

Vendor Totals Checker This utility compares the vendor totals listed under 
setup > vendors to the total unpaid invoices on your vendor aging. 

A/P Exception Report This utility looks for incorrect uses of a/p control 
accounts. Example, you should not credit accounts payable when writing a 
check. The a/p exception report would flag this transaction.

A/R Quick Check This report compares the total of your client aging to the 
total of a/r control accounts designated under Setup>Chart of Accounts. This 
is a quick way to make sure your agings stay in balance.

Client Totals Checker This utility compares the client totals listed under view 
> clients to the total unpaid invoices on your client aging.

A/R Exception Report This utility looks for incorrect uses of a/r control ac-
counts. Example, you should not debit accounts receivable when entering a 
client payment. The a/r exception report would flag this transaction.

JE Client Number Checker The JE Client Number checker will list any je to an 
income or job cost account that does not have a client code. This could affect 
the overhead allocation and Client P & L report.

Time Entry Client Checker The time entry client number checker will list 
any time entries in the current year that do not have a client code. This could 
affect the overhead allocation and Client P & L report.

Task Kind Checker The task kind checker looks for tasks on open jobs that 
have unbilled amounts, but the estimating/billing checkbox is not selected 
for that task. 
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The Auditor window
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1  Click the All button to select 
all of the Auditor’s steps.

2  A log showing the steps 
completed by the Auditor can 
be printed by clicking the Print 
button.

3  The steps needed to audit 
the books are listed here, in the 
order in which they’re per-
formed. 

4  You can selectively choose 
which steps to perform by click-
ing on a step’s checkbox. Only 

those steps that are checked 
will be performed.

5  The completed column 
indicates when each auditing 
step has finished. You can use 
the completed times to track 
how much time was needed to 
perform each audit. 

6  The status message keeps 
you constantly informed about 
the process of the auditor.

The Auditor can only check the account totals themselves, ensuring that they add up 
correctly.  It can’t make value judgements about how users have entered data.  
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The Overhead Allocation Worksheet helps calculate the true cost of servicing 
your clients. It works by first adding up the total hours worked by staff mem-
bers on each client account, using entries from time sheets and time cards. 
Then the agency’s total overhead is calculated from the income statement. 
The agency’s total overhead is then divided up by client using one of four for-
mulas: agency direct service costs, agency billings, agency income, or agency 
direct client hours. Based on the formula you’ve chosen, Clients & Profits 
allocates each client’s share of 
the overhead expenses. 

At the top of the Overhead 
Allocation Worksheet report 
you’ll see the month-to-date 
total overhead expenses, direct 
service costs (i.e., staff salaries), 
net overhead expenses (i.e., 
total overhead less staff sala-
ries), and total client hours. The 
report then shows two sections: 
one for client 
hours and one for overhead 
allocation. 
The “client hours” section lists clients 
and their month-to-date total hours, 
in order by hours used. The “overhead 
allocation” section lists clients and 
their share of the agency’s overhead
expenses.

Overhead expenses are allocated based 
on four different formulas. There are no 
restrictions on how you use these formulas 
(for example, you can run four separate reports for same month using each of 
the four different formulas). The overhead allocation formulas include:

Agency Direct Service Costs This popular formula allocates overhead ex-
penses based on the percentage of staff salary dollars used by each client. It 
looks at the actual cost (using the real payroll amounts, which you enter into 
the worksheet) of the hours worked on each client by each staff member. It’s 
the most commonly used method for allocating overhead.

Agency Billings This formula allocates overhead based on each client’s total 
billings. For example, if a client represents 50% of the month’s total billings, 
then half the agency’s expenses are allocated to the client.
Agency Income This formula allocates overhead based on each client’s gross 

Overhead Allocation Worksheet

Overhead Allocation Worksheet

profit. Unlike the Agency Billings formula, this formula allocates expenses 
based on the client’s billings less its job costs. With this formula, clients that 
are more profitable get a higher proportion of the agency’s expenses.

Agency Direct Client Hours This formula allocates overhead based strictly on 
the amount of billable hours worked by staff members on each client. Unlike 
the other formulas, non-billable administrative time is not a factor. Only time 

added specifically for a client is 
used. With this formula, clients 
with the most direct staff hours 
will get the most allocated 
overhead.

■ The amounts in the Overhead 
Allocation Worksheet report 
will appear on the Client P&L 
report. For security reasons, the 
staff salary and client overhead 
allocation amounts aren’t 
saved. Also, they only appear 
on the overhead allocation 

worksheet report. The allocation amounts are recalculated each time the 
worksheet is run.
 

Allocate overhead. The 
Overhead Allocation 
Worksheet is run for one 
accounting period at a time. 
Clients & Profits X compares 
the agency’s overhead 
expenses with client hours 
and the actual payroll costs 
to calculate each client’s 
share.
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The Overhead Allocation Worksheet window
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1 The payroll amounts can be 
cleared from the Overhead Al-
location Worksheet by clicking 
the clear button.

2 The Overhead Allocation 
Worksheet can be printed by 
clicking on the print button.

3 Choose to print the Overhead 
Allocation Worksheet report to 
the screen or to the printer from 
the print to pop-up menu. The 
report is automatically printed 
when the worksheet is saved.

4 The Overhead Allocation 
Worksheet can be run for one 
accounting period at a time.

5 The formula used to calculate 
each client’s portion of the 
overhead costs is selected from 
the Use allocation formula pop-
up menu.

6  A list of each staff member 
that has time entered for the 
period selected, will be listed 
with a MTD column to manually 
list their payroll amounts. The 
total of the MTD payroll column 

will be deducted from the total 
overhead costs for the month to 
give the net overhead expenses.  
The net overhead expenses 
will be allocated to each client 
based on the formula selected.

y

For security reasons, the staff salary and client overhead allocation amounts aren’t 
saved and only appear on the overhead allocation worksheet report. 
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Close Year

Closing the year in Clients & Profits X is extremely important and should 
be done sometime after the end of your fiscal year. Since Clients & Profits 
supports two simultaneous fiscal years (for a total of 24 accounting periods), 
there’s no real sense of urgency about year-end closing. The year can be 
closed well into the next fiscal year. Throughout that time you can enter data 
into both the current year and last year, then print financial statements for 
any accounting period.

Once in the new fiscal year, you should run the Close Year tool as soon as 
you’ve made any remaining adjusting entries. Closing is performed by a 
special tool that prepares your database for the next year’s accounting work. 
Closing the year does not affect job tickets, time sheets, accounts payable 
invoices, purchase orders, client invoices, payments, or checks in the check-
book. Instead, closing only resets the General Ledger.

■ You can’t enter data into a year that is closed: Once an accounting year 
is closed, its journal entries are permanently purged in preparation for the 
new year. So you can’t enter any last-minute entries into last year once it is 
closed. Any forgotten entries will have to be entered into the new accounting 
year.  

Closing the year takes all day (or all night), so don’t start the process until 
you have free computer time. Remember, no one can use Clients & Profits X 
while you’re closing the year. (If they do, they’ll lose their work.) You’ll see an 
“ok” message when the year has been successfully closed. Once the year has 
been closed, you and your users can start entering work into the new year. 
Before you close the year you should be able to answer “yes” to the following 
questions: 

■ Have you posted everything? All transactions should be posted before the 
close year process is performed.  Transactions posted to periods 13-24 will 
be automatically moved to their corresponding periods 1-12 and will become 
part of the next year’s financial data.

■ Have you printed any desired or required year-end reports? Once the year is 
closed, the year’s income statements, audit trails, and other financials can’t 
be printed because the information is no longer part of the database. Also, 
consider printing client, vendor, and resource summaries before closing the 
year, as well as the most recent financial statements. These reports will be 
cleared and reset for the new year as the year is closed.

■ Have you backed up your database? Closing is irreversible. Once the year is 
closed, it cannot be “unclosed” for any reason. Because of this it is important 
to make a permanent backup of your database, to allow you to reference the 
previous year’s general ledger if you ever need to.

The Retained Earnings 
account

The Retained Earnings account 
keeps track of your net income/loss 
from year to year. To close the year, 
you must have a Retained Earnings 
account. 

You’ll be prompted to enter 
the Retained Earnings account, 
which must be an equity account, 
when closing the year. Clients & 
Profits calculates the agency’s net 
income by subtracting job costs 
and overhead expenses from total 
income. The amount of your profit 
is then posted to retained earnings, 
an equity (or “net worth”) account. 
This is the same as manual entries 
which close income, costs, and ex-
penses into retained earnings––it’s 
just automated. Clients & Profits 
will prompt you if the account does 
not exist. 

■ Retained Earnings is a separate 
Equity account, and is not the same 
as the Year-to-Date Profit account 
#999999.  

1 Reconcile your bank accounts 
from the Checkbook.

2 Reconcile other balance sheet 
accounts using the G/L Reconcili-
ation.

3 Print any last-minute financial 
statements, including A/R and A/P 
agings for your hard-copy files.

4 Make a permanent backup of the 
current year’s database on a Zip, 
Jaz, Syquest, or other kind of drive 
or tape. 

You may need to refer to a previous 
year’s journal entries some time in 
the future, so having a permanent 
(and easily accessible) backup is 
handy.

5 Choose Accounting > General 
Ledger, then choose Edit > G/L 
Tools > Close Year.

6 Enter your Retained Earnings 
account, then click OK.

The completed steps are checked 
off in a list so you can check the 
progress. The close year process 
takes several hours. It can be run 
unattended overnight or over a 
weekend. For best performance, run 
the close year utility from the file 
server itself, not a user’s worksta-
tion (so you can avoid working 
across the network).

7 Confirm that the year was closed 
successfully by printing a YTD Trial 
Balance.

The Balance Sheet should not have 
a net income account listed under 
“equity.” The Income Statement 
should not have any balances. 
And the Year-to-Date Trial Balance 
should only have amounts for the 
beginning balances of the balance 
sheet accounts.

To close the year

Need more info about closing the year? Get a list of frequently-asked questions 
from the Clients & Profits X web site: www.cnp-x.com/support
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The Close Year window

1 A log showing the steps 
completed during the year-end 
closing can be printed by click-
ing the Print button.

2 The Close Year tool takes 
the shop’s YTD income (i.e., 
income less job costs and 
expenses) and moves it to your 
retained earnings (or owner’s 
equity) account. The retained 
earnings equity account keeps a 
year-to-year running total of the 
shop’s profit. 

3 The steps needed to close the 
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books are listed here, in the or-
der in which they’re performed.

4 The completed column 
indicates when each step of 
the year-end closing process 
has finished. You can use the 
completed times to track how 
much time was needed to close 
the year. 

5 The status message keeps you 
constantly informed about the 
process of the year-end closing.

Close Year

Closing is irreversible.  Make sure all last minute entries have been entered before 
you close.  Otherwise, any forgotten entries will be added to the new accounting year.


